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OTM Version 2.1 

The OTM software version release 2.10.56 was released last October and is the 
upgrade for OTM version 2.01.50. Important new features include support for: 

●     Windows 2000 Service Pack 4 
●     A USB dongle 
●     3.0 Succession Branch Office 
●     The Western Telematic Netlink Buffer Box for CDR and Traffic storage 
●     Improved Call Party Name Display (CPND) functionality 

Many customers had asked about the support for Windows XP and are now able to 
run their OTM clients on this operating system. Another customer concern was that 
different versions of OTM required different Windows 2000 service pack levels. In 
the past, OTM version 1.0 was supported only with SP1; version 1.1 was supported 
only with SP2; versions 1.2, 2.0 & 2.01 were supported only with SP3. 

When Service Pack 4 was introduced in June of last year, many customer network 
engineers insisted on the use of SP4 for security reasons, but, as stated above, the 
more recent versions of OTM would only be supported under SP3. Nortel has 
provided a Product Advisory Alert dated November 7th, 2003 in Bulletin Number 
PAA-2003-0398 which details the proper procedures for installing OTM versions 
1.2, 2.0 and 2.01 with Service Pack 4. Note that OTM versions prior to 1.2 are not 
supported with SP4. You must upgrade to a supported version of OTM. As the 
bulletin states, newer Microsoft patches and their compatibility with versions of OTM 
will be addressed in future product advisories. 

Prior versions of OTM required the use of a parallel port to house the OTM dongle 
(security key). Many new PCs are being sold without a parallel port installed off the 
motherboard. Installers have unsuccessfully tried to substitute a PCI add-on card 
with a parallel port. Nortel supports only hard-wired motherboard parallel ports and 
now, with the release of OTM 2.1, USB ports, that are more common on new PCs. 
The USB port requires a USB dongle that is different from the parallel dongle. It is 
important, then, to coordinate with customers and educate them regarding the port 
options for the PC that they intend to use for their OTM Servers or stand-alone 
machines, to ensure the correct dongle is ordered. As stated in the Nortel 2.1 GRB, 
"with OTM 2.10 and later, only onboard (direct from the PC motherboard) ports, 
either parallel or USB, will be supported." 

Script files have been included with OTM 2.1 to facilitate the usage of the WTI 
Netlink buffer box. This box can be polled serially via a direct-connect or modem, or 
via the customer's network to collect CDR and/or Traffic data. The Netlink is sold 
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with different memory capacities from 512K to 8M and is available through ISI. 

The facilitation of names within OTM has been improved with better links between 
the Station Administration and CPND modules, and the Employee Editor. With a few 
clicks, a name can be added, deleted or modified and it will be updated in the three 
locations in OTM as well as the PBX. The example below in Figure 1 shows the new 
interface for a station record in the Station Administration module. Use the 
Directory Options box to: 

●     Create a new employee 
●     Create a new role/project 
●     Assign a phone to an existing entity 
●     Unassign a phone to an entity 

Figure 1

 

For a new employee, select the option in the Directory Options box, and click on the 
Details box. The following Employee Editor screen appears. Enter the information 
for First and Last Name and click on the Apply button as shown in Figure 2. Then, 
click OK to return to the main phone screen of Figure 1. Clicking OK on the main 
phone screen generates the Schedule box. 

Figure 2
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To assign a phone to an existing entity of the Employee Editor, use the Assign to 
existing entity option in the Directory Options box, and click on the Find button. 
Next, locate the record in the editor, then click Apply and OK. For this operation 
you will need to open the CPND module, click the View menu and go to Pending. 
Then highlight the record(s) that you have created and transmit them to the PBX. 

To unassign a name to a phone, use the Do not assign to an entity option in the 
Directory Options box. This will blank out the First Name and Last Name boxes on 
the phone screen. Click OK. Note that this disassociates a name with a station 
record in OTM. It does not delete the name from the PBX. If you desire to delete the 
display name in the PBX, open the CPND module, click on the View menu, and 
proceed to CPND Name. Highlight the record to be deleted. If the Synch Status is 
set to OUT, you can transmit it to the PBX. If not, use the Delete key to change the 
status to OUT. You will then be prompted with the Scheduler box. 
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Exporting of Corporate Directory in OTM 2.1 

OTM 2.1 includes an improvement to the Corporate Directory Export utility, by 
providing Asset Listing information. This option is available under the Corporate 
Directory View as seen in Figure 1 below and can be accessed from the Utilities 
menu under the System Window. 

Figure 1

 

Once a File/Database Type has been chosen and a File/Database Location has 
been determined, click on the Format button to reveal the new Asset entries in the 
Available Columns pane. They are: Asset ID, Asset Type, Asset Value and 
Asset Value 2. These can be seen in Figure 2 below. Figure 3 shows where the 
asset values reside in the Employee Editor/Directory. They include values for Asset 
ID, Terminal Number, Extension and Location. 

Figure 2
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Figure 3
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Creating Phantom Phones with OTM 

There are many uses for Phantom phones on a Meridian 1 or Succession 
Communication Server for Enterprise 1000 system. By creating Phantom Terminal 
Numbers, administrators are allowed to configure them in software only and with a 
phantom Directory Number. There is no actual physical hardware. Calls that are 
made to a phantom DN are redirected to an existing phone via a set feature. 

Feature Package 254 is required for phantom configuration. Note that only 
500/2500 analog phones can be built on Phantom TNs, and they can only be 
assigned Single Appearance DNs. 

For this to be operational, a Phantom Loop (Superloop) must be configured. This is 
processed manually via the PBX terminal in Loads 17 or 97. Note: The OTM Overlay 
Passthru, VT220 System Terminal, or the Web Navigator's Virtual Terminal Server 
can also be used for direct access to the PBX. In most cases a Superloop will be 
created in Load 97. Once the loop is created, and the virtual card is added in the 
OTM Hardware view, the TNs are available for assignment to Phantom phones in 
the OTM Station Administration module. This is shown below in Figure 1. 

Figure 1
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The virtual card must be recognized in OTM. Therefore, open the Station 
Administration module and click on View. Then proceed to the Hardware menu 
and click Edit, then Add. In the Hardware Configuration box as seen above in 
Figure 1, select the PHT4D500 Quad Density 500/2500 Phantom Card from 
the drop-down list. Also, enter the applicable Loop, Shelf and Card numbers for 
the address of the phantom card. The example shows Loop 64, Shelf 1, Card 0. 
When finished, click OK. This will make sixteen Phantom Terminal Numbers 
available in the Station Administration Station view for the creation of Phantom 
2500 sets. To return to the Station view, click on View > Station. 

To build a Phantom set, click Edit, and then Add. Choose the 2500 Digitone 
Standard as an Instrument to add, and check the Phantom box as shown below in 
Figure 2. Click OK to advance. 

Figure 2

 

A phone view will appear where you must assign a TN, DN, Location, and Single 
Line features. Defining the name and department field is optional. Double-click on 
the Terminal Number box to display the TN list as shown below in Figure 3. 
Notice that 064 0 01 00 through 064 0 01 15 are available for assignment to 
phantom sets. Highlight and choose a TN, then click OK. Also, enter the Terminal 
Number in the Location box. 

Figure 3
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Following the TN assignment, provide a DN for the phantom set and assign a name 
via the Employee Directory by clicking on the Directory button. The last important 
task is to define the DCFW Single Line Feature. Use the Feature bar to scroll and 
highlight the Default Forward option as shown below in Figure 4. Click on the Set 
button and assign the Redirection DN length. The example shows four. Then, 
assign the Redirection DN. The example shows 5000. Click the Set button once 
again to assign the values and when finished, click OK and transmit to the PBX. 

Someone calling extension 6025, whether internally or remotely, will immediately 
be connected to extension 5000, which in the example is the pilot number for the 
voicemail system. Another application could be for incoming 800 numbers that have 
DNIS. You could direct the DNIS number to the proper location. 

Phantom sets can be handy, especially if cabinet space is at a premium and TN 
availability is low. They can help save real analog ports for actual phone sets or 
modem lines. 

Figure 4
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M1 Patches 

There are recent M1 patches available to correct the following items. 

The first is generated at the console as: 

PDT in Progress. Please Wait....Done! 

ABORT (PDT_INTERNAL_ERROR_WRONG_SLOT_NUMBER

This affects systems using X11 Release 25.40B 

It can be fixed by patch #MPLR16648. 

Patch #MPLR16464 corrects a problem regarding the addition of a key based 
module on a 3904 set in OTM. If you enter a "1" in the Key Based Module box and 
then transmit to the PBX, you can monitor the log window where it appears that the 
add-on module is created. However, this is not the case. The script file enters a "1" 
at the KBA prompt, and then a "0" at the DBA prompt, but this fails to create Keys 
32 through 53. Therefore, when you try to assign values to the new keys, it errors 
out on transmission. 

If the patch is not installed, you can build the add-on module manually from the 
PBX console by entering a "1" at the KBA prompt and then entering through the 
DBA prompt instead of entering "0". 

Patch P17575 corrects a problem with the M1 and Call Pilot where incoming calls to 
Call Pilot generate extremely long duration CDR records. The inaccurate call records 
also contain an incorrect date. 
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TBS Filter Usage 

Customers occasionally have difficulty with OTM TBS filter configurations in their attempts 
to run call accounting reports. Most report failures are attributable to improperly built 
filters. Below are examples of common reporting requests requiring the use of certain 
filters, with the correct way to configure the filters. Figure 1 below shows the main TBS 
report page with the Cost Analysis tree expanded to the Exception Chronological 
Report. To the right is the ellipsis for filter creation and assignment. The example shows 
the trunk filter is being used for this particular report. 

Figure 1

 

Figure 2 shows the layout for the trunk filter with the Extension/Trunk tab selected to 
include all calls that were outgoing and terminated on route 27. Note the Low and High 
values of 27001 and 27024. These are the ranges that are defined in Telephone 
Configuration as depicted in Figure 3. Figure 4 shows how they appear in the Call 
Database. Further note that the values must be entered into the filter as they appear in 
the Call Database. Use the other tabs to filter the date of the call (Call Date), Time, etc. 
Figure 5 shows the resulting report. 

Figure 2
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Figure 3

 

Figure 4
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Figure 5

 

Other tabs on the filter screen include Account Code, Authorization Code, Call Date, Call 
Frequency, Calling Line ID (CLID), Cost, Digits Dialed, Duration, Hold Time, Organization, 
Ring Time and Time. 

Include a date range with the Call Date tab. Fill in the From and To boxes. For example, 
enter 10/01/2002 to 10/31/2002 for the month of October 2002. The date can also be 
entered as 10/01/02 to 10/31/02. Note that these fields are dependant on the PC's 
Regional Time and Date settings. 

The filter shown below in Figure 6 is configured to report on incoming and outgoing calls 
for only extension 5000. Note that there must be a separate entry defined for calls that 
are outgoing (Originating) and incoming (Terminating). 
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Figure 6

 

Figure 7 below shows a digits dialed filter that uses the ? wildcard to account for a four-
digit access code in a CDR record, and then the digits of 12045671111. The *asterisk 
wildcard could be substituted for the four question marks, but note that a question mark 
is for one individual digit whereas an asterisk is for any number of digits. Observe the Call 
Database to determine how your digits dialed are being output from the PBX. The manner 
in which they are displayed in the Call Database is the way they must be defined in any 
digits dialed filter. 

Figure 7

 

Figure 8 below shows a filter configured to report on calls for only the Accounting and 
Sales departments. To be able to utilize this organizational type of filter, the hierarchy 
information must be defined in the Organizational Hierarchy Editor and assigned in 
the Employee Editor. Each of these databases can be accessed from the main TBS 
window under the Edit menu. Many of the filter tabs can be used in conjunction with one 
another, but it's important to recognize that only calls that meet all the requirements will 
appear on a given report. Also, sometimes it is better to click on the Exclude circle to 
look for calls that do not match any of the tab settings. With a little practice one can 
become proficient in proper filter configuration and generate successful reports. 

Figure 8
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Import Utility - Alternate Key 

OTM 2.1 is now capable of using the Terminal Number as an Alternate Key entry 
for the System Window Import Utility. This utility is frequently used for globally 
importing data such as organizational information. (See Keeping Connected : Fall 
2003 - "Importing the OTM Hierarchy.") OTM version 2.01 was not consistently 
allowing the TN to be designated as an Alternate Key as the software intended. 
Using the TN as an alternate key is ideal since it is a unique item that can be 
matched during an import. 

The example below shows the format of a file for importing three Organizational 
levels, using the Terminal Number Asset as the Alternate Key. When the import 
is launched, if a TN from the import file matches a TN in the Employee Editor, the 
Organization information will be assigned for that record. 

Figure 1 
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